
Instructions for Authors: Kabbalah: Journal for the Study of Jewish Mystical Texts 
Daniel Abrams and Avraham Elqayam, Editors <danielabrams@hotmail.com> <elqaya@mail.biu.ac.il> 

Cherub Press web page and catalog: www.cheurb-press.com 
Please read carefully 

Acceptance to ‘Kabbalah’ 
All contributions will be referred to specialists in a double-blind reading process, where neither reader nor author knows the identity 
of the other. Authors are therefore requested to omit references to previous studies in the first person. Please include name, address, 
phone, and any fax or e-mail address in correspondence. 
   Submission of a paper will be held to imply that it contains original unpublished work that has not been published or submitted 
elsewhere, in whole or in part, including versions in other languages. Manuscripts submitted should be complete, not awaiting any 
further research or permission to publish (letter of permission to publish manuscript texts must accompany submission; see below). 
Authors should contact the editor in advance regarding unique situations, including irregularly long studies or any technical 
problems.  
    If accepted to Kabbalah, the author will be required make the necessary changes, corrections and/or revisions as specified by the 
editors. The author will also receive at this time a contract for transference of copyright to Cherub Press which must be completed 
before proofs are prepared. A timetable for an accepted article’s printing can only be confirmed after the above has been received. 
Significant and/or unreasonable changes to the proofs, as determined by the editors, will be charged to the author.  
     Authors of full length studies, as determined by the editors, will receive one complimentary copy of the issue in which the piece 
appears, to be mailed by surface mail from Cherub Press’ offices. It is understood that authors will directly fulfil any agreements 
they have with third parties, providing copies of their studies to the libraries which granted permission for its publication. 

Submission of Contributions 

All submissions to Kabbalah should be made electronically as attached files to the email address listed above. Editors will promptly 
confirm the arrival of the file in a response by email.  
     All files must be submitted in Word for Windows format! It is your responsibility to provide a readable file that accords with the 
style instructions below.  
     The editors use Office/Word XP running on Windows XP PRO which allows for almost any character set including files which 
use both Hebrew and Arabic. Do not use Dagesh or other software for these purposes. If you use Macintosh you may try and send an 
all English file in RTF format as an attachment and the editors will respond regarding the quality of the conversion. Do not send 
Macintosh diskettes as they cannot be read by IBM computers. If your file includes other character sets or you use Nisus (and 
Hebrew), you will need to go to a specialist to convert your files (at your expense). We know of one such service but results vary so 
please work with the service you choose. You may wish to contact Ronit Nikolsky [email: msshingi@pluto.mscc.huji.ac.il, 
phone/fax 02-5635227, $10 per file; Daatz, 3a Metudela st., Jerusalem 92305]. Please be sure to check the final output in Word for 
Windows, through hardcopy or other means. 

Transliteration 
For transliteration of the het, tet ans tsadi please underline the h t and s. For example, hanoch, Metatron ans saddiq. For 
rules regarding transliteration see the Encyclopaedia Judaica, (Index volume, p. 90). 

Quotes and Indentations 

Paragraphs which begin studies, chapters or sections should not be indented. All quotes of significant length should be indented five 
characters from the right in Hebrew articles regardless of language of quotation and similarly from the left for Western language 
studies. Do not place quotation marks around indented quotations. Closing quotation marks should precede punctuation to be 
followed by footnote number, e.g. ‘xxxxxxx’.1 Do not place footnote mark before period or comma. Short quotations should be 
embodied within the body of the text within single quotation marks (so-called smart quotes ‘xxxx’, not straight lines, 'xxxx'). 

Bibliographic Citations in Notes 

Do not prepare a separate list of abbreviations to be published at the end of the study. The first reference to an article or book 
should always include the complete bibliographic information. Do not cite an article without giving name of author, full title of the 
study, journal title (not abbreviated) and page numbers. Titles of articles should be placed within single quotation marks ‘xxxx’. Do 
not use double quotation marks. Do not place a comma between the place/city and year of publication. Do not cite the names of 
publishers or series title. Your study will be returned for such corrections.  
     Additional references should be abbreviated, including the author’s last name (only) and a short title reference, e.g. Scholem, 
Major Trends, p. 15. Abbreviated references to article titles should be presented in single quotation marks, e.g. Scholem, ‘Colors and 
Their Symbolism’.  
     When writing in Hebrew, do not translate Western language names, titles or page references into Hebrew. Scholem’s Origins of 
the Kabbalah should be abbreviated as Origins, not מקורות. Further, the sentence should always end with a period in the 
direction/language of composition, regardless of the last word which appears.  

1
  .Scholem, Major Trends in Jewish Mysitcism, pp. 20-29: עיין

When writing in English please use the printed English title of a Hebrew work when available, followed by the word Hebrew in 
square brackets: [Hebrew]. The first full reference to a source must include the author’s name in the language it appears in the 
publication. Later references only require original language abbreviation and may otherwise follow the Hebrew format. Place short 
reference after (not within) the first full reference.  



     Page numbers should be cited in direction of language, that is from right to left in Hebrew. Cite exact page references only. Do 
not use ff. or f. Avoid citing chapters of books. Do not place a comma between journal title and volume number. List the volume 
number only omitting the number of the issue, assuming that page numbers are consecutive throughout the volume.  

  .498' עמ, )ד"תרצ-ג"תרצ(קרית ספר י ', לפירושים על עשר ספירותמפתח , 'גרשם שלום
G. Scholem, ‘Index to Commentaries on the Ten Sefirot’, Qiryat Sefer 10 (1934-1935), p. 498 [Hebrew]. 

Editors should be cited after title and not in parentheses following the title. In Hebrew the word בעריכת  should be used, and not 
:ערך  or ערכו: . Only the first initial of the editor's name should be used and no more than two editors should be cited. Further editors 

may be cited as et. al. Do not cite an article contained with in a volume with the word in and a colon (in: )בתוך / :  but as follows: 
1   Gershom Scholem, ‘The Concept of Kavvanah in the Early Kabbalah’, Studies in Jewish Thought: An Anthology of German 

Jewish Scholarship, ed. A. Jospe, Detroit 1981, pp. 162-180. 
  .141-162' עמ, ד"תל אביב תרצ, פיכמן' בעריכת י, ספר ביאליק', שה לתולדות ראשית הקבלהתעודה חד, 'גרשם שלום   1

Book titles should be italicized in all languages except Hebrew. Do not underline. Do not place a comma between the place and date 
of publication, and omit the name of the publisher. Please be consistent in citation of names; always cite the whole first name or the 
first initial, not both. Full first name of author is recommended in citation in body of text. First initials should be cited with a period 
in English and a single apostrophe in Hebrew שלום ' ג,  and not . שלום.  ג Two-part names should be cited with quotation marks 
between the two letters, e.g. א אורבך"א . Cities need not be hyphenated , )תל אביב, רמת גן ( nor should the construct form of Hebrew 
terms unless it so appears in a quote or title. Do not abbreviate city names, e.g. N.Y., L.A., א"ת , ם -י. The spelling of a city's name in 
Latin characters should correspond to its spelling in the book cited. When an author or place of publication is known but not printed 
in the original publication it should be included in square brackets. When no city is listed it should be indicated as [n.p.] and in 
Hebrew as ד"חמ[ ] and so with dates [n.d.] or [ ד"חש ]. In Hebrew both can be listed together as [ ד"חמוש ]. Capitalization in French 
and German should not follow English rules but those of the respective language. Please use proper French and German accents. Do 
not add an ‘e’ in lieu of an umlaut (ë).  

Facsimile Editions of Primary Sources 

Many editions of Kabbalistic works have been made available in facsimile editions, not all of them from the best or earliest printing. 
If you refer to such an edition please include full bibliographic details of the printing which was reproduced in the facsimile. In many 
cases it is advisable to include the verse commented upon or the chapter name or number. For example, Recanati's Commentary to 
the Torah was first printed in Venice 1523. Most scholars have used the Jerusalem 1961 facsimile of the Lvov 1880 edition which 
was originally published in pamphlets each of which contained a separate pagination. A full reference might appear as follows: 

. פרשת וארא, )ג"ע-ב"דף מ ע, א"צ ירושלים תשכ"ד(ד "ע-ג"דף ב ע, מ"לבוב תר, פירוש על התורה, מנחם ריקנאטי' ר  
     Where the various editions are not available please help the reader by citing (at a minimum) the specific edition consulted and 
chapter or pericope. So for example, cite chapters or sections of Ibn Gabbai’s ‘Avodat ha-Qodesh, Shem Tov Ibn Shem Tov’s Sefer 
ha-Emunoth, Cordovero’s Pardes Rimmonim and especially the works of Hayyim Vital. 

Collected Studies 

Cite last edition or version of secondary sources when possible. For example, cite Scholem's articles on Isaac Ha-Kohen and Moses 
of Burgos (Tarbiz 2-5) according to the pagination of the later volume ד"ירושלים תרצ, יצחק הכהן' לחקר קבלת ר  the page numbers of 
which appear in square brackets already in the volumes of Tarbiz. When citing from his study on Isaac and Jacob Ha-Kohen 
published in Maddaei ha-Yahadut 2 (1927) which was released separately as an independent volume, please give page references 
according to the Hebrew pagination which may be indicated by placed Arabic numerals in square brackets. Further, cite Scholem's 
series of articles in Qiryat Sefer according to the volume of collected studies א"ירושלים תרצ, פרקים לתולדות ספרות הקבלה  and cite 
from the collection of Sabbatean literature: 1991ירושלים , ליבס' ההדיר י, מחקרי שבתאות . 

Text Editions 

If editing a Hebrew text with an introductory study in another language, please annotate the text in Hebrew only. Texts in other 
languages may be annotated in the language of the introductory study. All editions submitted must include a copy of the letter from 
the owner of the manuscript granting permission to publish the text. A good quality copy of one sample page of the text is also 
requested for facsimile purposes. All diagrams, illustrations and photo-reproductions to be included in the author's study must be 
provided at author’s expense. 

Apparatus 

Difficult but near-certain readings should be presented in the base text in square brackets ] אאא[ unless otherwise noted. Additions 
from other manuscripts or additions inserted by the editor to the base text should be entered in angle brackets > אאא < with a footnote 
citing its source. Significant deletions in original manuscript should be cited in notes or in braces, e.g. אאא{ }. If a consistent source 
is used to complete the text presented, it should be discussed in the introduction. If an alternative system is used to the one described 
above it should be justified and/or explained. in the introduction. 
     Variant readings should be kept to a minimum although this remains the complete discretion of the editor of the study. It is 
recommended that one should only cite variant readings which alter meaning. If variant readings are kept to a minimum they can 
ideally be cited with the editors comments as footnotes. If variants are prepared according to line number, then the author should be 
aware that he/she will be required to re-enter in pen all the references to the line numbers to the variants to the according the new 
format of the printer's proofs . 



     Do not prepare editions (and variants) according to line number of original manuscript copying. Variants may be presented as 
endnotes divided into paragraphs by folio of base text. Do not prepare two sets of independently numbered footnotes for variants and 
editors notes. See past issues of Kabbalah for examples. 

Manuscript Citations 
When writing in Hebrew please use the full spelling of ‘manuscript’, כתב יד, and use the abbreviation י"כ  in footnotes and multiple 
references. Please avoid hyphenation in the construct form, especially כתב יד :  and not יד-כתב . Do not hyphenate the designation of 
the city and manuscript collection but instead use a comma, e.g. גינצבורג ,  מוסקבה  and not גינצבורג-מוסקבה . Library designations 
are necessary in most cases. Oxford, Paris, Milano and Jerusalem should be cited as מילנו; הספריה הלאומית, פריס; בודלי, אוקספורד ,

בית הספרים, ירושלים; אמברוזיאנה . Vatican and Munich manuscripts may be cited by city alone. The collection of the Jewish 
Theological Seminary of America (JTSA) should be cited as ל"בהמ, ניו יורק . Manuscripts of the British Museum are now referred to 
as the British Library הספריה הבריטית , לונדון . Manuscripts of Parma, Milano and Oxford should ideally include both catalog and 
shelf numbers, the latter in parentheses, but always numbering which runs throughout. So for example, always cite Neubauer's 
catalog number when possible as well as the Mic numbers of JTSA's collection. 
     Every manuscript reference must include the number of the microfilm reel in the Institute for Microfilmed Hebrew Manuscripts 
(located in the Jewish National and University Library, Jerusalem) in square brackets as such ]1129' סי[ , or in English [#1129]. If 
author does not have access to the Institute or the microfiche of their catalog which can be found in many major libraries throughout 
the world, please include a separate list of the manuscripts cited so editors can annotate the list and return it to the author. Do not cite 
manuscript catalogs unless necessary. Place a comma between manuscript number and folio designation, e.g.  דף , 209כתב יד מינכן

]1625' סי[ב 29-ב2 . Folios should be cited according to Arabic numerals unless otherwise numbered in manuscript, e.g. Hebrew 
letters. If two numbering appear in manuscript, please indicate when consistent numbering is not used. When pagination is provided 
by a counter which appears only in the microfilm, as in the case of the Parma collection, include such numbers in square brackets. 

Annotations 

Include folio numbers of base text manuscript witness in body of text in square brackets with Arabic numerals followed by the letter 
aleph or beth for recto and verso, e.g. [13א]. If text is in another language please use either a/b or r/v . 
     Include biblical and Rabbinic references of explicit quotations in body of text using parentheses. Titles of biblical books should 
be abbreviated and no comma should be placed between chapter and verse ) ו ד' דב ( and )א"חגיגה יד ע( . Citation of the tractate and 
folio is sufficient; it is not necessary to cite the Babylonian or Jerusalem Talmud, not the word מסכת. Biblical books should be 
abbreviated by their first two letters, exceptions being ' נחו, איוב, רות',  ויק for Nahum '  נחמ for Nehemiah, א"שמ ב"שמ ,  for Samuel I 
and II, and ב"דה, א" דה  for Chronicles I and II. When citing two verses please use semi-colon to separate them )לא יז; כ יא' שמ( . 
When a paraphrase of a verse is explicitly cited please indicate this ( א א' פ בר"ע ). Further citations from the same work or biblical 
book may be refer back to the same work ( א"דף לא ע, שם ) or: (שם שם). 
     When citing a biblical verse, sefer yezira, or a Rabbinic source, do not place comma between the two numbers, e.g. ספר יצירה (

)א"ג מ"פ  and not ) א"מ, ג"ספר יצירה פ ( or ) לג יג' ויק ( and not )יג,לג' ויק( . Citations of biblical verses in English should follow the 
new translation of the Jewish Publication Society unless otherwise noted. Biblical verses in English should be referred to by an 
abbreviated form of the book title and a colon between chapter and verse: (Gn. 1:26), (Ex. 23:21-23). When citing a journal title in 
Hebrew do not put quotation marks inside volume number כד תרביץ  and not ד"תרביץ כ . When citing the Talmud or Zohar please 
place quotation marks only in the folio designation א" ברכות לב ע and not א"ב ע"ברכות ל , and: א"רלג ע, א"זהר ח  and  not א"זהר ח ,

א"ג ע"רל .  
     Following these formatting guidelines will help expedite the printing process and will considerably reduce the amount of errors 
engendered from transferring your carefully prepared document to printer’s proofs. 

 Author’s Checklist:  
 Include your full name, address with zipcode and contact information including email and phone/fax?  
 Include the translation of the title of your study and the spelling of your name in both English and Hebrew? In the case of 

book reviews include the full bibliographic information of the book under reviews as it appears in that publication. 
 In bibliographic citations do not include publisher’s name and do not list the series in which book appears. 
 Do not abbreviate journal names; do not use roman numerals to cite volume numbers, and do not include issue number 

after volume number. 
 Use pp. before page numbers, not a colon. 
 Remove any commas between the city and year of publication. 
 Use smart quotes (rounded apostrophes). Do not use double quotation marks. You can make this the default in Word by 

checking ‘smart quotes’ in: Tools ⇒AutoCorrect ⇒ Format as you type. 
 Do not ctie the name of the editor of a volume prior to the title and including the word in with a colon (in:) prior to the title 

of the volume, or using the word (eds.) in brackets. The correct order is, name of Author of article, article, volume title, 
editor(s), city year, pp. 123-456. 

 When citing Hebrew studies in an English article, place the word [Hebrew] in square brackets after the full citation, i.e. 
after citing the page numbers, and not between the title of the article and the book in which it is contained. Do not use the 
abbreviation Heb. nor parantheses. 

 Search for bold and replace with italics (Edit-Find-Format-Font-FontStyle): Do not use bold or underlining at all. (Please 
use italics for volume titles and emphasis. Do not use italics for volumes when writing in Hebrew). 

 Did you underline letters to receive diacritic marks (see above) ? 
 Search for double spaces prior to submission (replace with single space). 
 Search and remove double paragraph breaks (Edit-Find: ^p^p). Do not use empty lines to set off paragraphs or sections. 
 Remove all tab marks. (Find: ^t). For indentation use Fomat-Paragraph-BeforeText (0.5 cm) 



 Use en dash – instead of a single or double hyphen which is surrounded by spaces. The en dash is found in 
Insert⇒Symbol⇒Special (The em dash is even wider). Do not use the en dash between page numbers. 

 Hebrew authors! The sequence of page numbers should follow the direction of Hebrew: smaller number on the right of the 
hyphen, larger on the left.  

 When a footnote of a Hebrew article closes with the citation of an English study, the period to close the paragraph should 
be entered in Hebrew (that is switch to Hebrew [shit+alt] before entering the period) and the period will then appear on the 
left of the paragraph, closing the paragraph as a Hebrew footnote overall!  

 Please be sure to include with your submission your name, full address with zipcode, contact phone number and email and 
the Hebrew and English translation and spelling of your name and study! 

 Upon acceptance for publication authors should complete the agreement found below and mail in a signed hardcopy to the 
editors as requested. 



AGREEMENT 

The parties to this Agreement are ________________________________ ("Author"), who is the Author of the Document entitled  
____________________________________________________________________________  
(the "Document") and Daniel Abrams, dba, Cherub Press, ("Cherub Press"), publisher of Kabbalah: Journal of the Study of Jewish 
Mystical Texts ("Journal"). The parties agree as follows: 

Copyright Assignment: Whereas Cherub Press is undertaking to publish the Document in the Journal, and whereas Author desires 
to have the Document published, now therefore Author grants and assigns the entire copyright in the Document to Cherub Press for 
its exclusive use. The copyright and the assigned rights include all rights of whatever kind or nature now or hereafter protected by 
the United States and all foreign countries, in all languages and forms of communication and in all media, in perpetuity, and Cherub 
Press shall be the sole proprietor thereof. Author reserves only one right consisting of the right to reprint the Document in whole or 
in part in any book (the "Book") of which Author is the sole Author, subject to Author's giving proper credit in the Book, in a form 
approved by Cherub Press, to the original publication of the Document in the Journal, and subject to the Book being published no 
earlier than one year after the actual publication and distribution of the volume of the Journal in which the Document appears, and 
subject also to Author's including the original copyright notice as it appears in the Journal in the credit included with the publication 
of the Document in the Book.  

Warranty: Author makes the following representations and warranties: (1) the Document is wholly original with the Author; (2) 
neither the Document nor any works of substantially similar content or form nor any translations of the foregoing into (an)other 
language(s) has been published, or submitted for publication elsewhere, in whole or in part, and no agreement to publish is 
outstanding; (3) Author has the right to assign the copyright to the Document to Cherub Press and no portion of the copyright to the 
Document has been assigned previously; (4) Author has obtained permission to publish any and all manuscript materials included in 
the Document from owner(s) of said materials and will submit a copy of the written permission(s) to Cherub Press prior to 
publication of the Document; (5) the Document contains no matter which is defamatory or is otherwise unlawful or which invades 
individual privacy or infringes or violates any copyrights or other rights of others. It is understood that the copyright to the 
Document has not been registered with the Library of Congress or other similar body, but that in the event such registration has taken 
place Author will promptly transfer the copyright to Cherub Press.  

Defense and Indemnification: If a third person makes a claim which if true would constitute a violation of the Author's 
representations or warranties, Cherub Press may defend against any such claim with counsel designated by Cherub Press, and 
Author will indemnify Cherub Press against all costs of such defense (including the fees and costs incurred by Cherub Press's 
designated counsel), and Author will pay the foregoing promptly upon their being incurred. Further, Author will indemnify and hold 
Cherub Press harmless from and against any damages, losses, costs and expenses suffered by Cherub Press arising out of any breach 
of any of Author's representations and warranties. 

Editorial Process: Author grants Cherub Press the right to edit and revise the Document which shall then be presented to the Author 
for his comments, but Cherub Press' decisions will be final. Author waives any droit morale and/or moral rights.  The Author will 
provide Cherub Press with the final and corrected version of the Document in “Word for Windows”. Author agrees to follow the 
written editorial format of Cherub Press, as defined by its editor(s). Author will be given an opportunity to read and correct proofs, 
whether camera-ready, from a laser printer or otherwise, but if Author fails to return them to the editor(s) of Cherub Press by the 
date set by the editor(s), production and publication may proceed without the Author's involvement. Cherub Press’ editorial 
decisions will in all cases be final. 

No Further Compensation: Except as expressly provided in this Agreement, Author will receive no monetary or other 
compensation from Cherub Press for the assignment of the copyright and publication of the Document in the Journal or for Author's 
entering into this Agreement. Without derogating from the generality of the foregoing, Author will receive no monetary 
compensation for other licenses which may be granted by Cherub Press for the use of the Document including reprints, anthologies 
or textbooks. Cherub Press will have the sole right to prosecute claims against third persons for copyright infringement of the 
Document. Author will co-operate with, and assist Cherub Press in, such prosecution, but Author will not be required to incur any 
expenses in connection therewith unless reimbursed by Cherub Press. Damages won will be the sole property of Cherub Press.  

Successors and Assigns: Cherub Press may from time to time license and/or assign all or any of its rights under this Agreement to 
any person or entity. This Agreement will be binding upon, and inure to the benefit of, the respective licensees, successors and 
assigns of the parties. 

Jurisdiction, Attorneys Fees and Applicable Law: In the event of any disputes or litigation rising out of or relating to this 
Agreement, the parties agree that all such matters shall be adjudicated in an appropriate court in the County of Los Angeles, State of 
California, United States of America, and the losing party shall pay the reasonable attorney's fees and costs incurred by the 
prevailing party. This Agreement shall be interpreted according to the substantive laws of the State of California and the United 
States of America applicable to contracts as if all relevant contacts are within the State of California. 

Severability: If any provision of the Agreement is determined to be invalid or unenforceable the remainder of this Agreement shall 
remain in full force and effect. 

Entire Agreement: This Agreement embodies all agreements between the parties and supersedes all agreements and understanding 
which may have existed whether oral or written relating to the subject matter of this Agreement and no other agreements, statements 
or premises relating to the subject matters of this Agreement shall be valid or binding unless executed in writing after the date of this 
Agreement referenced as an addendum or amendment to this Agreement and signed by both parties hereto. 



Rules of Construction: The captions in this Agreement are for convenience only and shall not be used to construe this Agreement. 
This Agreement shall be fairly construed without favoring either party and without reference to which party drafted all or any of the 
provisions. 

If the foregoing terms are satisfactory, please sign and date the Agreement. Please immediately return one copy to Dr. Daniel 
Abrams, Graetz 14, Jerusalem 93111 ISRAEL 

Accepted by Author: ______________________________   Date ________________ 
 
Please clearly print in English your name, mailing address and email. The address and email only will appear in "list of contributors" 
to be published in the volume:  
Name _______________________(English) _____________________________(Hebrew) 
Mailing Address (where you wish to receive your mail!):  
_______________________________________________________________________________ 
Email __________________ phone contact ____________________________________________ 
 
The volume includes two tables of contents, in Hebrew and English. Please write out your name and translation of the title of your 
article as should appear in this second Hebrew or English title page. 
_________________________________________________________________________________________ 
__________________________________________________________________________________________ 

 Author’s Checklist:  
 Include your full name, address with zipcode and contact information including email and phone/fax?  
 Include the translation of the title of your study and the spelling of your name in both English and Hebrew? In the case of 

book reviews include the full bibliographic information of the book under reviews as it appears in that publication. 
 In bibliographic citations do not include publisher’s name and do not list the series in which book appears. 
 Do not abbreviate journal names; do not use roman numerals to cite volume numbers, and do not include issue number 

after volume number. 
 Use pp. before page numbers, not a colon. 
 Remove any commas between the city and year of publication. 
 Use smart quotes (rounded apostrophes). Do not use double quotation marks. You can make this the default in Word by 

checking ‘smart quotes’ in: Tools⇒AutoCorrect⇒Format as you type. 
 Do not cite the name of the editor of a volume prior to the title and including the word in with a colon (in:) prior to the title 

of the volume, or using the word (eds) in brackets. The correct order is, name of Author of article, article, volume title, 
editor(s), city year, pp. 123-456. 

 When citing Hebrew studies in an Enlgish article, place the word [Hebrew] in square brackets after the full citation, i.e. 
after citing the page numbers, and not between the title of the article and the book in which it is contained. Do not use the 
abbreviation Heb. nor parantheses. 

 Search for bold and replace with italics (Edit-Find-Format-Font-FontStyle): Do not use bold or underlining at all. (Please 
use italics for volume titles and emphasis. Do not use italics for volumes when writing in Hebrew). 

 Did you underline letters to receive diacritic marks (see above) ? 
 Search for double spaces prior to submission (replace with single space). 
 Search and remove double paragraph breaks (Edit-Find: ^p^p). Do not use empty lines to set off paragraphs or sections. 
 Remove all tab marks. (Find: ^t). For indentation use Fomat-Paragraph-BeforeText 0.5 cm) 
 Use en dash – instead of a single or double hyphen which is surrounded by spaces. The en dash is found in 

Insert⇒Symbol⇒Special (The em dash is even wider). Do not use the en dash between page numbers. 
 Hebrew authors! The sequence of page numbers should follow the direction of Hebrew: smaller number on the right of the 

hyphen, larger on the left.  
 When a footnote of a Hebrwe article closes with the citation of an English study, the period to close the paragraph should 

be entered in Hebrew (that is switch to Hebrew [shit+alt] before entering the period) and the period will then appear on the 
left of the paragraph, closing the paragraph as a Hebrew footnote overall!  

 Please be sure to include with your submission your name, full address with zipcode, contact phone number and email and 
the Hebrew and English translation and spelling of your name and study! 

 Upon acceptance for publication authors should complete the agreement found below and mail in a signed hardcopy to the 
editors as requested. 


